SZECHENYI ISTVAN ALKALMAZOTT MECHANIKA
EGYETEM TANSZEK

Végeselem modszer 5. gyakorlat
U-gerenda

Feladat: U-gerenda modellezése lemezszerkezetként

Adott

Egy U180-as profilbdl késziilt gerenda az egyik végén befalazott, a masik végére egy 10 mm
vastag, 250x250 mm’-es négyzet alaku lemez van felerésitve, mely a terhelés felvételére és
tovabbitasara szolgal.

Terhelés
A gerendan 3 kiilonb6z0 terhelési esetet definialunk:
1. terhelési eset: Csavaras er@parral (gatolt csavards a 250x250 mm?-es lap miatt)
A és B pontban F, =5000 N
2. terhelési eset: Hajlitas és csavaras a gerinclemez felezépontjaban miik6doé erével
C pontban F, =5000 N
3. terhelési eset: ,,Tiszta” hajlitas a csavarasi kozéppontban hat6 erdvel
D pontban F, =5000 N



Anyagjellemzok
Az acél anyagjellemzoi:

E=21-10° MPa
v=0,3

A tarté geometriai méretei
a =180 mm v, =8 mm R, =11 mm
b =70 mm v, =11mm R, =5,5mm
a=3° | =1000 mm
¢ =250 mm v, =10 mm

Az U-gerenda keresztmetszetét lathatjuk a kovetkezd 2 abran. Baloldalon a valdsdgos
geometria van, a modellezéshez egy egyszersitett geometriat hasznalunk.

Valbsagos geometria Modell
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Feladat mindegyik terhelési esetnél:
— A kozepfeliilet deformalt alakjanak kirajzolasa, a csomoponti elmozdulas értekek
leolvasasa.

— Redukalt fesziiltségek (o, ) szemléltetése a kiilsd és a belsé feliileteken, valamint a kozép-
feliileten szintvonalas dbrékon.
— A radiranyt normalfesziiltségek (O'y) a kozépfeliileten szintvonalas abrakon.

A h¢j olyan test, melynek egyik mérete a masik ket merethez kepest kicsi. A legkisebb meret
a vastagsag. Ertelmezhetd kozépfeliilet, amely gorbiilt feliilet is lehet.

A Kirchhoff-Love-héjelmélet nem veszi figyelembe a nyirasi alakvaltozast. A hipotézis
szerint hajlitasnal a kozépfeliilet normalisai az alakvaltozds utan is normalisai lesznek az

alakvaltozott kozépfeliiletnek €s a normalisokon 1évé pontok tavolsaga nem valtozik.

Ha a héj kozépfeliilete parhuzamos az xy sikkal — ez az U-gerenda also és felsd lapja —, akkor
a geometriai hipotézis szerint y,, =y,, =0 és ¢, =0. Az alakvaltozasi allapot:
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A fesziiltségi hipotézis szerint o, = 0. A fesziiltségi allapot az also és felsé lapon:
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[£]= r, o, 0

0 0 O
A szamitasok elvégzéséhez a tartonak, mint héjszerkezetnek csak a kozépfeliiletét rajzoljuk
meg. A lemez modellhez sziikségiink lesz a kozépvonalak geometridjara. A kozépfeliileti

méreteket mutatja a kovetkezd abra.
A Kozépfeliileti méretek:

a’ :a—Z-%:a—vz ~180-11=169 mm

b =b-1-70-8 66 mm
2 2
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Inditsuk el az Abaqus CAE programot. Adjuk meg a munkakonyvtarat a File » Set
Work Directory... paranccsal. A megjelen6 ablakban a New work directory ala
irjuk/masoljuk be a munkakonyvtarunk helyét, vagy valasszuk ki a A select... ikonnal.
Ezutan OK-zuk le az ablakot.

Eile Model Viewport View

MNew Model Database [
Open... Ctrl+0
Metwork QDB Connector k
Close QDB...

Set Work Directory... Mote: In file selection dialog boxes, you can
click the work directory icon te jump Pl

Save Ctrl+5 to the current work directory.

save As.. Cancel

Compress MDB...

== Set Work Directory

|

Current work directory:

Ghgames\SIMULIA\tem

MNew work directory:

J\Google Drive\01_educ

P

ation\05_VEM\Abac

Il MODULE | PART | geometria megrajzolasa

A program megnyitasa utan alapértelmezésként a Part Modulban vagyunk. Ez a Modul
szolgal a geometria létrehozasara. Ehhez az alabbi Iépéseket kdvessuk:

1. Az eszkoztarbdl kattintsunk a Create Part ikonra. Az ennek hatasara megjelend Create

Part ablakban az alabbi beallitasokat végezzik el:

A Name utan irjuk be az alkatrészink nevét.
A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 3D geometriat

szeretnénk rajzolni.

A Type alatt hagyjuk az alapértelmezett kijeldlést a Deformable el6tt, mivel
alakvaltozasra képes geometriat szeretnénk.
A Base Feature alatt valasszuk a Shell-t. A Type-nal pedig az Extrusion opciot.
Az Approximate size-ot, tehat a modellink méretét itt is beallithatnank, de erre
majd késébb visszatérink a segédracs bedllitdsanal, most hagyjuk az

alapértelmezett 200-on.

A fenti beallitadsok elvégzése utan kattintsunk lent a Continue... gombra.

Module: | Part : S Create Part x
? E Mame: | Part-1
}i:- P Modeling Space
| Create ® 30 O 2D Planar () Axisymmetric
| Part
I Type Options
9,
L ® Deformable
-_1‘ ﬂ,‘_, () Discrete rigid
. “ MNone available
it () Analytical rigid
() Eulerian
.
R, 2=,
Base Feature
FJE‘ &j‘ Shape Type
e A O Solid Planar
7 @ Shell
J._-:j Y . Revolution
g o ) Wire
T Sweep
ﬂ, E‘ () Point
™ % Y
2 Approximate size: | 200
@ @ Continue.., Cancel




2. Az U gerenda geometriajanak megrajzolasahoz:

Valasszuk el6szér az eszkdztarbol a Create Isolated Point parancsot, majd adjuk
meg két sarokpont koordinatait alul a beviteli mezdben. Tehat irjunk be -33, 84.5 -6t
majd kézépsé gombbal fogadjuk el, ezutan irjunk be 33, -84.5 —6t majd szintén

fogadjuk el k6zépsé gombbal. Ezutan a grafikus ablakon megjelent a két pont.

Ezutan a Create Lines: Rectangle paranccsal rajzoljunk egy téglalapot, aminek

egy atlon 1évé ket ellentétes sarokpontja az el6bb megadott két pont.

A Delete paranccsal toroljik ki a téglalap jobb oldalat, hogy megkapjuk az U profilt.
Végul a beviteli mezében kattintsunk a Sketch the section for the shell extrusion
melletti Done gombra és a felugré Edit Base Extrusion ablakban a Depth sorba irjuk

be a kihuzas értékét, vagyis 1000 -et.

Module: |- Part

o~

Create
|solated
Peint

A | Pick a point--or enter X2 |-33, 24.5

X | Pick a point--or enter X, | 33, -84.9

A2.2

A2.3

Module: | Part

+

Create Lines:
Rectangle

{U (4 Lines)

A2.4

A2.5




Module: |5 Part

+ ot

A2.7 A2.8

A2.9

4= |2 Sketch the section for the shell extrusion |Done

= Edit Base Extrusion =
End Condition
Type:  EBlind

Depth: | 1000

Options
Note: Twist and draft cannot be specified together.
Dlinclude twist, pitch: |0

[ Include draft, angle: |0

Cancel

A2.10

A2.11

3. Az U gerenda megrajzolasa utan rajzoljuk meg a lemez geometriajat.
¢ A Name utan irjuk be az alkatrésziink nevét legyen lemez.

e A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 3D geometriat

szeretnénk rajzolni.

e A Type alatt hagyjuk az alapértelmezett kijeldlést a Deformable el6tt, mivel
alakvaltozasra képes geometriat szeretnénk.

e A Base Feature alatt valasszuk a Shell-t. A Type-nal pedig az Planar opciot.
e Az Approximate size-ot, tehat a modelltér méretét, amit allitsunk 250-re.
o A fenti beallitdsok elvégzése utan kattintsunk lent a Continue... gombra.

e Ezutan a Create Lines: Rectangle paranccsal rajzoljunk egy téglalapot, aminek

a mérete 250x250 mm vagyis a segéd racshalét keretezi korbe.




Ahhoz, hogy a vazlatbdl alkatrész legyen a lenti beviteli mezében kattintsunk a Sketch
the section for the planar shell melletti Done gombra (vagy nyomjuk meg a kézéps6
egergombot) Ennek hatasara elkészil a Part-unk, és visszaall a Part Modul alap
eszkdztara.

— Y
- Create Part it
Module: | Part -
1 Mame: | lemez
3:} Modeling Space
(o
Create ® 3D (O 2D Planar () Axisyrmmetric
| Part
. Type Options
9, e
g (® Deformable
f: -+ (O Discrete rigid
et —— . . Maone available
'l (O Analytical rigid
= .
(O Eulerian
o
o]
,_,:lm - Base Feature
o Shape Type
oyuies Osoid  |HEEEEEEG_
'i'j + @ Shell Extrusion
—F, ) Revolution
) Wire 5
5 Weep
g& E‘ O Point
@ @ Approximate size: | 230
Centinue... Cancel
A3.1 A3.2

Module: |5 Part

Create Lines:
Rectangle

4 Li
@ (4 Lines)

A3.3 A3.4




Il MODULE | ASSEMBLY I Zrler

Ennek a |épésnek tobb alkatrészbdl allé szerkezetek esetében van igazan jelentésége, mivel
itt tudjuk létrehozni az Osszeallitast. Kulon-kilon mar létrehoztuk a két alkatrészt most
készitenlnk kell a két alkatrészbdl egy 6sszeallitast. Ehhez kattintsunk az Assembly modul
Create Instance ikonjara, majd a Parts menupontnal jeloljik ki mindkét korabban létrehozott
alkatrészt majd kattintsunk az OK gombra. Ezutan a Merge/Cut Instances paranccsal
egyesitsiik a két alkatrészt. A felugré ablakba adjuk meg egy nevet, majd Continue. Ezutan
jeloljuk ki a két alkatrészt véguil lent a beviteli mezében a Select the instances to merge —nél
kattintsunk a Done gombra.

4= Create Instance =
Create instances from:
Module: |5 Assermnbly : @® Parts () Models
T s Parts

% o

- il
W Create sne
A Instance
= ==
I ©

1 Instance Type
&l. 'UJT—E (®) Dependent (mesh on part)

' ] Independent (mesh on instance)
=}

Note: To change a Dependent instance's
'+E E_'I mesh, you must edit its part's mesh,
0. [] Auto-offset from other instances
oK Apply Cancel
C1 C2
% Merge/Cut Instances X

Mote: This function will create a new part and

Module: |= Azzemnbly automatically instance it into the assembly.

Part name: | lemez_u_gerenda
Operations
® Merge
® Geometry () Mesh (") Both
(O Cut geometry

Opti
]ﬂ':’ @ ptions
2 Original Instances
i U (®) Suppress () Delete

3. | Instances

ra Geometry
= Intersecting Boundaries
Remove
e ® %
E\"“ E_-L () Retain %
C3 C4




[B NN tulajdonsagok megadasa

Valasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzéket, illetve rid
esetén a keresztmetszeti jellemzdket. Ehhez az alabbi 3 Iépésen kell végmenni:

1. Anyag definialasa: Els6é lépésként egy anyagot kell definialnunk. Ehhez a Property
modul eszkoztarabdl kattintsunk a Create Material ikonra. A megjelend Edit Material
ablakban végezzik el a kévetkez6 beallitasokat:

o Nevezzik el az anyagot: a Name:
e A linearisan rugalmas anyagjellemz6k megadasahoz a Material Behaviors
mezd6ben adjuk ki a Mechanical » Elasticity » Elastic parancsot
o Az ekkor megjelend Elastic mez6ben az alabbi beallitdsokat végezziik el:
oA Type mellett hagyjuk az alapértelmezett Isotropic-ot (az
anyagtulajdonsagok iranyfliggetlenek)
o A lenti Data tablazatban a Young’'s Modulus ala irjuk be a rugalmassagi
tényez6t, azaz 2.1e5 (MPa) —t, a Poisson’s Ratio ala pedig a Poisson
tényez6t, azaz 0.3-at.

= ¢ Edit Material X Y
5 b Edit Material x
Module: | Property -
Name: | Material-1 Name: | Material-1
7 = Description: 7 Description: 3
Material Behaviors Materis! Behaviors
— eetc |
i
i Create
Material
3 ==
General | Mechanical Thermal  Electrical/Magnetic  Other General  Mechanical Themmal  Electrical/Magnetic  Other #
=
E == Elastic
Plasticity b Hyperelastic
n2 Damage for Ductile Metals 3 Hyperfoam Type: | Isotropic M ~ Suboptions,
nl Damage for Traction Separation Laws b Low Density Foam [ Use temperature-dependent data
&l t Damage for Fiber-Reinforced Composites b Hypoelastic 5
a f 5 Number of field varisbles 0%
Damage for Elastomers *  Porous Elastic
Deformation Plasticity Viscoslastic Moduli time scale (for viscoelasticity): Long-term ]
r [E= Damping [ No compression
Expansion [ No tension
Biittle Cracking -
ata
® @
: Viscosiy Modgos oo
: e sty v e
i IS
=, o3
r
‘,/ - — oK Cancel
[ 1

2. Section definidlasa: A Property Modul eszkéztarabdl kattintsunk a Create Section
ikonra. Az ekkor megjelend Create Section ablakban az alabbi beallitasokat végezzik
el haromszor:

o Nevezzik el a section-t a Name sornal elészér V1, majd V2 és V3 néven
e A Category alatt valasszuk ki a Shell —ot
e A Type alatt valasszuk a Homogeneous —t, ezutan kattintsunk a Continue...
gombra.
o A felugré ablakban a Shell thickness Value sorba adjuk az egyes Section-ok
vastagsag értekeit V1-nél 8-at, V2-nél 11-et, V3-nal 10-et.
Ezutan kattintsunk az OK gombra, és ismételjuk meg a lépéseket mig mindharom
section-t meg nem adtuk.




Medule: |: Property IE
7
B Create

Section
!-.|:
B, 7
£

=

= Create Section >

Mame: | V1

Category — Type

O sol
Composite

) Beam Membrane
Surface

(0) Other

General Shell Stiffness

5 Edit Section

MName: V1

Type:  Shell / Continuum Shell, Homogeneous

Section integration: (® During analysis () Before analysis

Basic = Advanced

Thickness
Shell thickness: @) Value: 8
() Element distribution:
() Nodal distribution:
Material: Material-1 M Bz

Thickness integration rule: @ Simpson (O Gauss

Thickness integration points: | 55

B

& = Optiens:
oK Cancel
4% Edit Section
Name: V2
Module: [% Prope E %5 Create Section X
-| Property - Type:  Shell / Continuum Shell, Homogeneous
2> Marme: | V2 Section integration: @) During analysis () Before analysis
fs :
Basic  Advanced
i Category |~ Type Thickness
:EI‘ Create P . R—
Section @ Cgmp05|te () Element distribution:
; f(x}
Membrane O Nodal distribution: a
(C) Beam
2
B E:intl ) Other Surface Materisl: | Material-1 Y Ee
3 ‘ General Shell Stiffness Thickness integration rule: @ Simpson () Gauss
g P
m- Thickness integration points: | 5
o s
0K Cancel
4 Edit Section
T "p—[ Name: V2
2 o .
odule: |5 Property 4 Create Section * Type:  Shell / Continuum Shell, Homogeneous
g g Section integration: @) During analysis () Before analysis
l{ E Mame: | V3
Basic  Advanced
i Category — Type Thickness
Bl Create
:Il Section @ Shell Composite () Element distributicn: a
f(x)
EI ES] (7) Beam Membrane O Nodal distribution:
n2 Surface
BEs \t"t‘ () Other ) Material: | Material-1 M B
A " General Shell Stiffness
Thickness integration rule: ® Simpson () Gauss
ﬁ* - Thickness integration points:| 5%
Continue... Cancel
Options: &,

OK

Cancel

B2.7

B2.8

B2.9

Section-6k geometridhoz rendelése: Ehhez kattintsunk a Property modul eszkoztarabdl

az Assign Section ikonra. Ezutan jeldljuk ki az U gerenda gerincét, majd a lenti beviteli
mezdben kattintsunk a Done gombra majd a felugré ablakban valasszuk ki a V1-es
section-t, majd OK. Ezt a 1épést még kétszer kell megismételnunk. Jeldljuk ki az U
gerenda dvlemezeit és rendeljik hozza a V2-es section-t. Végul jeldljuk ki a 250x250-es

lemezt és rendeljuk hozza a V3-as section-t.
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43¢ Edit Section Assignment *®

Module: :Prupert_y Region
Region: Set-1
g o
|£ £ Section
Section: | V1 M &

)
! Assign ‘

Note: List contains only sections
applicable to the selected regions.

Type:  Shell, Homogeneous

Material: Material-1

Section
)

&=
L=

Thickness

Assignment: ® From section () From geometry

Shel Offset
Definition: |Middle suface v &

A -
oK Cancel

S Edit Section Assignment x
Medule: :Property Region

Region: Set-2
T a
/e Secton

Section: |V2 V-3

23
E Assi.gn
e
=

L=

-

Note: List contains only sections
applicable to the selected regions.

Type:  Shell, Homogeneous

Material: Material-1

Thickness

Assignment: @ From section (O From geometry

Shell Offset
Definttion: | Middle surface | &

oK Cancel

B3.6

B3.4

& Edit Section Assignment pe
Module: |5 Property Region

Region: Set-3
¥, -
e Secon

Section: | V3 M %

)
E Assign ‘

Section
= S
&
@

-

Note: List contains only sections
applicable to the selected regions.

Type  Shell, Homogeneous

Material: Material-1

Thickness

Assignment: @ From section () From geometry

Shell Offset

Definition: |Middlesuface || &

oK Cancel

B3.9

B3.7

] MODULE | STEP | I6pések megadasa

A Step modulban a végrehajtandé vizsgalat(ok) tipusat (pl. statikus, dinamikus, hétani...),
azok részleteit és sorrendjét tudjuk beallitani. Jelenleg 1 db statikus Iépést kell definialnunk.
Ehhez kattintsunk a Step modul Create Step ikonjara. a megjelené Create Step ablakban
nevezzik el a [épést: a Name -nél. A Procedure type-nal valasszuk a Linear perturbation-t.
Ezutan kattintsunk a Continue... gombra, majd a megjelené Edit Setup ablakban hagyjunk
mindent alapértelmezésen, csak OK-zuk le.
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2= Create Step x

aF Edit Step he

Mame: | Step-1
Name: Step-1
Module: : Step ] Insert new step after Type: Static, Linear perturbation
Description: |
m E=
e E Nigeom: Off
p| Create
e
| Step
ol =
11040 ===
K Proceduretype: | Linear perturbation v
R. a2 Buckle
r]E '3; Frequency
O Static, Linear perturbation
[avz) /L Steady-state dynamics, Direct
7 . Substructure generation
Pt
b Dy
oK Cancel

:F MODULE | MESH halo elkészitése

A végeselem halot a Mesh modulban tudjuk elkésziteni. Legel6szor fent az Object-et allitsuk
at Part-ra, majd a lenyilé fulnél valasszuk ki a lemez_u_gerenda alkatrészt.

Module: |: Mesh E| Model: | Model-1 E| Object: (7) Assembly @ Part: = lemez_u_gerenda :
fin B,

Ezutan a haldzast az alabbi lépésekben végezzik el:

1. Lemez felllet felvagasa:

Els6 1épésként mivel még nem hoztuk létre azokat a pontokat, amikre a terhelések meg
kell adnunk ezért elséként felvagjuk a lemez fellletét ugy, hogy ezek a pontok
kiadddjanak. Ehhez kattintsunk a Partition Face: Sketch ikonra. Majd jeldljik ki az a
fellletet, amit fel szeretnénk vagni, tehat kattintsunk, a lemezre majd kézépségombbal
fogadjuk el a kijelélést. Ezutan a lenti beviteli mezében valasszuk ki a vertical and on
the left opciét ezutan pedig kattintsunk az U gerenda gerincének lemezzel érintkez6
vonalara. Ekkor visszakapjuk a sketch modult, amiben rajzoljuk meg a Create Lines:
Connected paranccsal azokat a vonalakat, amik mentén a fellletet felvagjuk (lasd a
lenti abran). Ezutan az Add Dimension paranccsal méretezzik be a berajzolt
fuggbleges vonalat a gerinchez képest 25.16 mm-re. Végul kattintsunk a beviteli
mez&ben a Done gombra.
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Medule: |5 Mesh

4] Setectan ecigeor s that will pest

ssstully

| he top
Jser=\asdf\Docunents\Abagus felagherizontsland onthebottom s cae®

F1.2

F1.3




F1.5

2. Elemtipus megadasa:
o Kattintsunk a Mesh modul Assign Element Type ikonjara.
o Jelbljuk ki a teljes geometriat.
e Alenti beviteli mez6ben kattintsunk a Done gombra
e A megjelené Element Type ablakban a Family-t allitsuk Shell-re, a Geometric
Order-t pedig legyen Quadratic, majd OK-zuk le az ablakot.

4F Element Type ®
Element Library Family
@ Standard () Explicit Heat Transfer ~
Membrane
Geometric Order Surface
O Linear @ Basiraii v
Module: |5 Mesh
Quad  Tri
3 “ Element Contrals
e =
h DOF per node: 05 @6
§ 7] @ Drilling hourglass scaling factor: @ Use default () Specify
% E\/ Viscosity: ® Usedefault (O Specify
— Element deletion: @ Use default (O Yes (O No
Assign Max Degradation: @) Use default (O Specify
Elemnent Type
i, 5=l
58R: An &-node doubly curved thick shell, reduced integration.
Note: To select an element shape for meshing,
select "Mesh-> Controls” from the main menu bar.
oK Defaults Cancel

3. Elemméret megadasa:
Ehhez az alabbi Iépéseket végezziik el:
e Kattitnsunk a Mesh modul Seed Part ikonjara.
e A megjelené Global Seeds ablakban az Approximate global size mez&ben irjunk
be 8 -at. Ezutdn OK-zuk le az ablakot.
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e |
& Global Seeds X
Sizing Controls
Module: |5 Mesh Approximate global size: | 8
L L Curvature control
— £l Maximum deviation factor (0L0 < h/L < 1.0%: | 0.1
E____ (Approximate number of elements per circle: 8)
#_ﬁ @ Minimum size control
%;; %‘ (®) By fraction of global size (0.0 < min < 1,0} | 0.1
— (@] By absolute value (0.0 < min < global size) | 5
OK Apply Defaults Cancel

Négyszdg alaku strukturalt hald megadasa: Kattintsunk az Assign Mesh Controls

ikonra ezutan jeldljik ki a teljes geometriat majd kattintsunk a kézépsé gombbal. A
felugr6 Mesh Controls ablakban az Element Shape-nél allitsuk be a Quad-ot a
Technique-nél pedig a Structured menupontot, majd kattintsunk az OK-ra.

Madule: |5 Mesh
Fo [b,

2= Mesh Controls X

Element Shape
® Quad O Quad-dominated () Tri

- Technigue Algorithm Options
& & Minimize the mesh transition ig*
IEEE ) Free |:|
s
@ (O Sweep |:|
Pﬂ‘ Redefine Region Corners...
QK Defaults Cancel
F4.1 F4.2 F4.3
5. Végeselem hald elkészitése:

A végeselem halo elkészitéséhez kattintsunk a Mesh modul eszkoztaraban a Mesh Part
ikonra, majd a lenti beviteli mezében az OK to mesh the part? mellett a Yes gombra.

Module: | Mesh : Model:l

o [E
i
s B

OK to mesh the part? [%}

F5.1

F5.2
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F5.3

6. Haldtulajdonsagok lekérdezése (opcionalis)
A csomodpontok és végeselemek szamanak ellenérzéséhez a Tools » Query...
Parancsot hasznalhatjuk. A felugr6 Query ablakban a General Queries mezdben
kattintsunk a Mesh-re, majd a lenti beviteli mez6t a Query entire part-on hagyva a Done
gombra. Ekkor a lenti parbeszédablakban megjelenik a csomépont szam (Total number
of nodes) és az elemszam (Total number of elements).

=l MODULE | LOAD | peremfeltételek megadasa

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogasokat) és
dinamikai peremfeltételeket (terheléseket). Jelen feladatban 1 megfogast és 4 terhelést kell
definialni.

1. megfogasok definialasa: (az alabbi Iépéseket kétszer kell végcsinalni)

e Kattintsunk a Load modul Create Boundary Condition ikonjara.

o A megjelené Create Boundary Condition ablakban nevezzik el a megfogast, a
Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step
alatt pedig valasszuk ki a Symmetry/Antisymmetry/Encastre-t. Ezutan
kattintsunk a Continue... gombra.

o Jeldljuk ki a rajzon a megfogas megdfelel6 helyét (kijeldléskor egy piros vonal
jelenik meg a kijeldlés helyén).

e A lenti beviteli mez6ében kattintsunk a Done-re

e Az ekkor megjelend Edit Boundary Condition ablakban a fix megfogas esetén
valasszuk az ENCASTRE (U1=U2=U3=UR1=UR2=UR3=0). OK-zuk le az
ablakot.

befalazas
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Medule: | Load :
L
L ER

Create
Boundary

[ Condition
T sl |

El.1

# Create Boundary Condition X
Mame: BC-1

Step: | Step-1 M

Procedure: Static, Linear perturbation

Category Types for Selected Step

® Mechanical Symmetry/Antisymmetry/Encastre
(O Electrical/Magnetic | Displacement/Rotation
O Other Connector displacement

Continue... Cancel

E1.3

I
Select regions for the boundary condition ( [¥] Create set: ) %

El.4

5 Edit Boundary Condition x

Mame: BC-1
Type:  Symmetry/Antisymmetry/Encastre
Step:  Step-1 (Static, Linear perturbation)
Region: Set-1

CSYS: (Global) [ L

(O XSYMM (U1 = UR2 = UR3 = 0)

(O YSYMM (U2 = UR1 = UR3=0)

() ZSYMM (U3 = UR1 = UR2 = 0)

(DI XASYMM (UZ=U3=UR1 =0 Abaqus/Standard only)
(O YASYMM (U1 = U3 = UR2 = 0; Abaqus/Standard only)
(O ZASYMM (U1 = U2 = UR3 = 0; Abaqus/Standard only)
(O PINMED (U1=U2=U3=0)

(®EMNCASTRE (U1=U2=U3=UR1=UR2 = UR3 =0}

oK Cancel

E15
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2. terhelések definialasa: (a lenti Iépéseket négyszer kell megcsinaini)

o Kattintsunk a Load modul Create Load ikonjara.

o A megjelen6 Create Load ablakban nevezzik el megoszlo terhelésnek, az erét
pedig koncentralt erének. . A Category-t hagyjuk az alapértelmezett Mechanical-
on, a Types for Selected Step alatt pedig valasszuk ki a Concentrated Force-ot
koncentralt er6 megadasnal. Ezutan kattintsunk a Continue... gombra.

o Jeldljuk ki a rajzon a koncentralt er6 helyét. (kijeldléskor egy kis piros pont jelenik
meg a kijel6lés helyén).

e A lenti beviteli mezében kattintsunk a Done-re

o Az ekkor megjelen6 Edit Load ablakban adjuk meg az er6komponensek
nagysagat N-ban: (CF1=5000, majd CF1=-5000, ezutan CF2=-5000 vegul CF2=-
5000)

F1 erépar fent F1 erépar lent
Module: |+ Load j Madule: | = Load :
&E? Et&
ET; Create Create-
Load Load
e k= B3
= T
E2.1 E2.6
4 Create Load X 5 Create Load w0
MName: | F1_fent Name: F1_|El'1i
Step: | Step-1 ~ Step: | Step-1 e
Procedure: Static, Linear perturbation Procedure: Static, Linear perturbation
Category Types for Selected Step Category Types for Selected Step
@ Mechanical [Concentratedforce | L (Concentratedforce |8
Moment Moment
O Acoustic Pressure O Acoustic Pressure
Shell edge load Shell edge load
Surface traction Surface traction
(O Electrical/Magnetic Body force (O Electrical/Magnetic Body force
Line load Line load
(O Other Gravity (O Other Gravity
Pipe pressure Pipe pressure
Generalized plane strain Generalized plane strain
Rotational body force Rotational body force
Coriclis force Coriolis force
Connector force Connector force
Connector moment Connector moment
Inertia relief v Inertia relief v
Continue... Cancel Cancel
E2.2 E2.7
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E2.8

e

Select points for the load ( [¥] Create set: )

E2.3
T
Select points for the load [ [V] Create set:
E2.4
& Edit Load X

Mame: F1_fent

Type:  Concentrated force

Step: Step-1 (Static, Linear perturbation)
Region: Set-2

E2.9

CSVS: (Global) [ L

Distribution: | Unifarm N fix)
CF1: 5000

CF2:

CF3:

[ Follow nodal rotation

Note: Force will be applied per node.

QK Cancel

E2.5

= Edit Load b

Mame: Fl1_lent

Type:  Concentrated force

Step: Step-1 (Static, Linear perturbation)
Region: Set-3

C5¥s: (Global) [p L

Distribution: | Uniform | i)
CF1: -5000

CF2:

CF3:

[ Follow nedal rotation

Note: Force will be applied per node.

oK Cancel

E2.10

F2 ero

F3 eré

Module: |5 Load :
Eﬂ

I B2

Module: |5 Load :
&ﬂ

D;l Create

Load

= B2
T B2

E2.11

E2.16




# Create Load
Mame: |F2
Step: | Step-1 ™

Procedure: Static, Linear perturbation

Category Types for Selected Step
(® Mechanical Concentrated force ~
Therma Moment
O Acoustic Pressure

Shell edge load
Surface traction

O Electrical/Magnetic Body force

L Line load

(O Other Gravity
Pipe pressure
Generalized plane strain
Rotational body force
Coriclis force
Connector force
Connecter moment

Inertia relief

Continue...

Cancel

% Create Load *
Marme: | F3
Step: | Step-1 ~

Procedure: Static, Linear perturbation

Category Types for Selected Step
(® Mechanical Concentrated force -~
Therma Moment

() Acoustic Pressure
. Shell edge load

Surface traction

() Electrical/Magnetic Body force
Iy ion Line load

() Other Gravity
Pipe pressure
Generalized plane strain
Rotaticnal body force
Coriolis force
Connector force
Connector moment

Inertia relief

Continue... Cancel

E2.12

E2.13

E2.17

E2.18

Select points for the load ( Create set:

e

Select points for the load ( [] Create set: | TEH] ) m

E2.14

E2.19

% EditLoad

Name:  F2
Type:  Concentrated force

Region: Set-4

Step:  Step-1 (Static, Linear perturbation)

C5YS: (Global) [p L

Distribution: | Uniform ™
CF1:

CF: -5000

CF3: I

[ Follow nodal rotation

Note: Force will be applied per node.

fix)

0K Cancel

= Edit Load *

Mame: F3

Type:  Concentrated force

Step:  Step-1 (Static, Linear perturbation)
Region: Set-5

CSYS: (Global) [ L

Distribution: | Uniform M fix)
CF1:

CF2: -5000

CF3:

[ Fellow nodal rotation

Mote: Forcewill be applied per node.

QK Cancel

E2.15

E2.20
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3. Terhelési esetek megadasa:

o Kattintsunk a Load modul Create Load Case ikonjara.

e A megjelend Create Load Case ablakban nevezzik el terhelési eseteket. Ezutan
kattintsunk a Continue... gombra.

o Az Edit Load Case ablakban a Load fulén kattintsunk a zdéld + ikonra (Add).
Jeldljuk ki a listabdl a terhelési esetnek megfelel6 terhelést. Ezutan OK gombra
kattintsunk.

o Az Edit Load Case ablakban Iépjunk at a Boundary Conditions fildre kattintsunk a
zold + ikonra (Add). Jeldljtk ki a listabdl a terhelési esetnek megfeleld
megfogasokat. Ezutan OK gombra kattintsunk.

¢ Majd kattintsunk a OK-ra

1. terhelési eset - F1 er6par 2. terhelési eset - F2 erd 3. terhelési eset — F3 erd
Module: | Load e Module: | Load e Module: | Load e
L L 1=
I b m
(= e (=
= = I
Create Create Create
{| Load Case || Load Case I| Load Case
. o I
s
5 Create Load Case X % Creste Load Case ot 2= Create Load Case %
Mame: | F1_eréipal Mame: | F2_erd Name: |F3_erd
Step: | Step-1 e Step: | Step-1 1] Step: | Step-1 e
Procedure: Static, Linear perturbation Procedure: Static, Linear perturbation Procedure: Static, Linear perturbation
I ——————————————————————— P
k. -
5 Edit Load Case x 2 Edit Load Case x 2 Edit Load Case X
Name megoszlt letheles Mame: kencentralt erd Mame: megoszlé + koncentralt
Step: terhelisiiesctek (Staticibmcarpeiubation) Step:  terhelési esetek (Static, Linear perturbation) Step:  terhelési esetek (Static, Linear perturbation)
Leads  Boundary Conditions Loads  Boundary Conditions Loads  Boundary Conditions
Click mouse button 3 for table options. Click mouse button 3 for table options. Click mouse button 3 for table options,
Name Scale Factor Name Scale Factor Name Scale Factor
1 1 1 1 1 1
+ & i d t #
s
t selections in viewport t selections in viewport Highlight selections in viewport
oK Cancel i Cancel oK Cancel
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4 Load Selection *
Load Type

F1_fent Concentrated force
Fl1_lent Concentrated force

F2 Concentrated force

F3 Concentrated force

Scale factor: | 1

Highlight selections in viewport

¢ Load Selection X
Load Type

F1_fent Concentrated force
F1_lent Concentrated force

F2 Concentrated force

F3 Concentrated force

Scale factor: 1
Highlight selections in viewport

4+ Load Selection x

Load Type

F1_fent Concentrated force
F1_lent Concentrated force
F2 Concentrated force

F3 Concentrated force

Scale factor: |1

Highlight selections in viewport

OK Dismiss

0K Dismiss

E3.4

E3.10

OK Disrmiss

E3.16

% Edit Load Case X

Name: megoszlo terhelés

Stept  terhelési esetek (Static, Linear perturbation)

Loads

In addition te selections below, use all boundary
conditions propagated or medified from the base state,

Click mouse button 3 for table options.

4% Edit Load Case b4

Mame: koncentralt erd

Step:  terhelési esetek (Static, Linear perturbation)

Loads

In addition to selections below, use all boundary
conditions propagated or modified from the base state,

Click mouse button 3 for table options.

5 Edit Load Case bt
Name: megoszlé + koncentralt
Step:  terhelési esetek (Static, Linear perturbation)

Loads | Boundary Conditions

In addition to selections below, use all boundary
conditiens propagated or medified from the base state.

Click mouse button 3 for table options,

BC-1 Symmetry/Antisymmetry/E|

Scale factor: | 1

Highlight selections in viewport

BC-1 Symmetry/Antisymmetry/E|

Scale factor: |1

Highlight selections in viewport

Name Scale Factor Name Scale Factor Name Scale Factor
1 1 1 1 1 1
+ & & + &
selections in viewport I ht selecti i t
t selections in viewport e
OK Cancel oK Cancel
oK Cancel
—] Boundary Condition Selection X —] Boundary Condition Selection X —] Boundary Condition Selection *
Boundary Condition Type Boundary Condition Type Boundary Condition Type

BC-1 Symmetry/ Antisymmetry/E|

Scale factor: | 1

Highlight selections in viewport

oK Dismiss

E3.6

QK Dismiss

E3.12

oK Dismiss

E3.18

el MODULE | JOB | feladat megoldasa

A feladatot a Job modulba atlépve tudjuk lefuttatni. Az ehhez szilkséges Iépések:

1. Feladat definialasa:

e A Job modul eszkdztarabdl kattintsunk a Create Job ikonra
¢ A megjelend Create Job ablakban kattintsunk a Continue... gombra
e A megjelend Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le
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Mame: | Job-1

Source: | Medel EI

[Contipue... [ Cancel
L g

= Create Job Iﬁ

2= Edit Job -

Name: Job-1
Modzl: Model-1
Analysis preduct: Abaqus/Standard

Description:

Submission | General | Memory | Parallelization | Precision

Job Type
@ Full analysis
() Restart
Run Made
@ Background () Queue:

Submit Time

@ Immediately

e

Gl.1

G1.2

G1.3

2. Feladat lefuttatasa:

e A Job modul eszkdztarabdl kattintsunk a Job Manager ikonra

¢ A megjelend Job manager ablakban alapbdl ki van valasztva az elébb definialt 1
db feladat (Job-1). Kattintsunk a Submit gombra.

e Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen
lefutott. Az eredmények megjelenitéséhez kattintsunk a Results gombra.

Module: |2 Job H "2 1ot Manager | (2 o0 Manager =)
[
= | Name Model Type Status Name Model Type Status
-
@ﬂ i Job
Manager
i ==
iib g e e e e e o)
- ]

: H EYeDUN=NRYIEIS/ARVI N[O ]\ credmények megjelenitése

A Results gombra Kkattintva automatikusan a Visualisation modulba kerllink. Fent
valasszuk ki az U-t vagy az S-t annak megfeleléen, hogy az elmozdulast, vagy a fesziltséget

szeretnénk megjeleniteni. EI8sz6r valasszuk az U-t.
T

tauhs [o] g0~ : B [primay  [<] ] tises
oF

E
RF

5

e

e

4

A Plot Contours on Deformed Shape ikonra kattintva a deformalt alakot lathatjuk.
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ODB: Job-1.0db  Abaqus/Standard 3DEXPERIENCE R2017x  Thu Nowv 02 14:35:19 GMT+01:00 2017

Step: Step-1 o
Load Case: F1_EROPAR
U, Magnitude

Bal feliil lathat6 szinskala alapjan a maximalis elmozdulas 1,324-10" mm, azaz 13,24 mm.

A Contour Options-ban a Limits fulén bekapcsolhatjuk a max/min helyek megjelenitését.
MIOQUIE: |5/ VISUBNZATION < Contour Plot Optans. -8 i

| | Basic I Color & Style | Limits | Other

Q- 422 E% | Note: User-defined interval values override

L2314 the settings below.

! =n UJ Mal Min/Max
B H mae @ Auto compute (0.0190805) (¢! Show location
+-i

i Specify: 0.0190808
B B 1 N

H M @ Auto-compute () 4| Show location

| | |
Q “'____ + Specify: @
o,

+
4| Auto-Computed Limits
Contour Opticns H|| When auto-computing animaticn limits
I Use limats from all frames v{
+
+
+
1 &x | _Apply | | Defaults | Cancet

Az elmozdulasok kiértékelése utan nézzik meg a redukalt fesziltség eloszlast.

FE: Primary E| u E Magnitude E|
CF
E

RF
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ODB: Job-1.0db Abaqus/Standard 3DEXPERIENCE R2017x Thu Now 02 14:35:19 GMT+01:00 2017

Step: Step-1 o
Load Case: F2_ERD
B ;

QODB: Job-1.0db Abagus/Standard 3DEXPERIENCE R2017x  Thu Nov 02 14:35:19 GMT+01:00 2017

Step: Step-1
Load Case
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